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Introduction

Welcome to Sage ACT! 2012. Sage ACT!, the #1 Contact and Customer Management choice of small
businesses and sales teams, is designed to help you build the long-lasting, profitable relationships your
business thrives on.

Who Should Use This Guide?
You should use this guide if you have one of the following versions of ACT! or Sage ACT! installed:

e ACT!, ACT! Premium for Workgroups, or ACT! Premium for Web 2005 (7x.)

e ACT! by Sage, ACT! by Sage Premium for Workgroups, or ACT! by Sage Premium for Web 2006
(8.x)

e ACT! by Sage, ACT! by Sage Premium, or ACT! by Sage Premium for Web 2007 (9.x)

e ACT! by Sage, ACT! by Sage Premium, or ACT! by Sage Premium for Web 2008 (10.x)

e ACT! by Sage, ACT! by Sage Premium, or ACT! by Sage Premium for Web 2009 (11.x)

e ACT! by Sage, ACT! by Sage Premium, or ACT! by Sage Premium for Web 2010

e Sage ACT! Pro, Sage ACT! Premium, or Sage ACT! Premium (access via web) 2011

e ACT! by Sage for Financial Professionals or ACT! by Sage Premium for Financial Professionals
versions 2007 (9.x), 2008 (10.x), 2009 (11.x), or vi2. Important: Before upgrading, see

"Addendum A: Upgrading from ACT! by Sage for Financial Professionals (All Versions)" on page
12.

e ACT! by Sage Premium for Real Estate 2006 (8.x), ACT! by Sage for Real Estate or ACT! by Sage
Premium for Real Estate versions 2008 (10.x), 2009 (11.x), or vi2. Important: Before
upgrading, see "Addendum B: Upgrading from ACT! by Sage for Real Estate (All Versions)" on
page 16.

To determine the version of the product you are using, check the version number (from the Help
menu, select About). After the upgrade has been installed, the version number will read “14.x.x.x".

If you do not have ACT! or Sage ACT! installed, or one of the above versions, then DO NOT USE this
guide. Instead, see the appropriate guide:

I do not have any version of ACT! or Sage ACT! installed. You are a "New User." See the
Installing Sage ACT! 2012 for New Users guide available as a PDF on the installation panel under
Product Documentation.

I have ACT! 3.x, 4.x, 5.x (2000), or 6.x (2004) installed. See the Upgrading to Sage ACT!
2012 from ACT! versions 3.x, 4.x, 5.x (2000), or 6.x (2004) guide available as a PDF on the
installation panel under Product Documentation.

Adobe® Reader® is required to access and view product documentation from the installation panel.
For instructions on obtaining Adobe Reader, see "Installing Other Applications" on page 9.

About This Guide

This guide explains how to upgrade to Sage ACT! 2012 or Sage ACT! Premium 2012.

Sage ACT! Premium includes access via Windows® (desktop) and web. If you are installing access for
users via the web, then you will need this guide and the Sage ACT! Premium 2012 Web
Administrator's Guide to complete installation and configuration. The Web Administrator's Guide is
available on the web product's installation panel under Product Documentation. You can browse the
installation files directory for the guide as well. It is recommended that you read the Web
Administrator's Guide before installing the web version.

Features exclusive to Sage ACT! Premium or Sage ACT! Premium (access via web) are noted in the
guide. In most sections, we refer to all versions as Sage ACT! 2012.
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Who Can Install This Upgrade?

You can install this upgrade if:

e You are a single user with an ACT! or Sage ACT! database on éour computer and that database is
Microsoft® Desktop Edition (MSDE), or Microsoft SQL Server™~ 2000, 2005, or 2008 Express.

See the Important information below if you use Microsoft SQL Server 2000 Standard Edition or
2005 Standard Edition.

e You are one of several ACT! or Sage ACT! users accessing the same database and that database
is not on your computer.

Use this document to apply the upgrade to every computer that accesses Sage ACT!, including
the computer hosting the database. Make sure all users are upgraded at the same time to
prevent issues accessing the database.

e You are an ACT! Premium for Web, ACT! by Sage Premium for Web (any version), or Sage ACT!
Premium 2011 (access via web) user.

To upgrade your current web product to Sage ACT! Premium 2012 (access via web), you need
this guide and the Sage ACT! Premium 2012 Web Administrator's Guide to complete installation

and configuration. The Web Administrator's Guide is available as a PDF on the installation panel
under Product Documentation.

Important: If you, or your organization, use an ACT! Premium version, including ACT! Premium for
Web 2005 or 2006, with Microsoft SQL Server 2000 Standard Edition or 2005 Standard Edition and
you want to upgrade to Microsoft SQL Server 2008 Standard Edition R2 for use with Sage ACT!

Premium 2012, contact your ACT! Certified Consultant* or Sage ACT! Corporate Sales for assistance
to upgrade your current product.

*Certified Consultants are third-party vendors. Sage and its affiliates are in no way liable or responsible for claims made
related to the services provided by third-party vendors.

What You Should Know Before Upgrading to Sage ACT! 2012
Upgrading to Sage ACT! 2012 requires that you understand:
e The upgrade considerations and recommendations.
e Database synchronization recommendations.
e When to downgrade a premium database.
e Itemsthat do not upgrade.

Be sure to read the entire upgrading document before beginning the upgrade.

Database Upgrade Considerations and Recommendations

The process for upgrading to Sage ACT! 2012 involves upgrading an existing database. Review the
following considerations and recommendations before you upgrade.

The database upgrade process overwrites the earlier version database. It is important to
have a backup copy of the database in case you want to re-install the earlier version of the software.
Back up the database before starting the upgrade process.

Who can upgrade a database? An ACT! Administrator or Manager user can upgrade a local
database. An Administrator, Manager, or Standard user (if there is no active Administrator user) can
upgrade a remote (Subscriber) synchronized database they belong to. See the section "Database

Synchronization Requirements" for information about whether or not you can upgrade a remote
database.

No upgrade required for database supplemental files. Database supplemental files, such as
templates, reports, and layouts, do not need to be upgraded for use in Sage ACT! 2012.

Sage ACT! 2012
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Changes for ACT! Premium for Web 2005 and 2006 users Preferences folder. The user
Preferences folder location changed in versions after ACT! Premium for Web 2006. You can restore the
preferences by copying all files to the new Preferences path. See the Sage ACT! Premium 2012 Web
Administrator's Guide.

Database Synchronization Recommendations

Customers upgrading from ACT! by Sage 2010 (12.x) or Sage ACT! 2011 (13.x) do not need to
recreate their remote databases. You can upgrade a remote database after you install Sage

ACT! 2012. However, customers on versions other than ACT! by Sage 2010 and Sage ACT! 2011,
should follow these recommendations.

ACT! or ACT! Premium for Workgroups 2005 (7.x), or ACT! by Sage or ACT! by Sage
Premium 2006 (8.x) customers. The database synchronization relationship is lost. We
recommend you synchronize remote databases to one, main (Publisher) database before upgrading to
Sage ACT! 2012. Then, you upgrade the main database and create new remote databases.

ACT! by Sage or ACT! by Sage Premium 2007 (9.x), ACT! by Sage or ACT! by Sage
Premium 2008 (10.x), or ACT! by Sage or ACT! by Sage Premium 2009 (11.x)
customers. The database synchronization relationship is retained. However, because of opportunity
data changes made in ACT! by Sage 2010, we recommend that you synchronize remote databases to
one, main (Publisher) database before upgrading. Then, you upgrade the main database and create
new remote databases. The new opportunity data changes will synchronize. For further instructions,
see "Upgrade Changes That May Affect Where Your Data Appears" on page 5.

Sage ACT! 2012 allows you to create up to 50 remote databases at one time.

When To Downgrade a Premium Database

If you currently use a Premium version of ACT! and you plan to install Sage ACT! Pro 2012, a non-
premium version, you must prepare the database, or downgrade it, to work with the non-premium
version before you install Sage ACT! Pro 2012. You need the Premium application to do this. For
further instructions, see "Downgrading a Premium Database" on page 11.

Items That Do Not Upgrade

Note the following items that do not upgrade.

Menu/toolbar and column customizations. Customizations are lost. You must redo your
menu/toolbar and column customizations. See the Help for information about menus and toolbars you
can customize in Sage ACT! 2012.

Welcome Page customizations. If an ACT! Certified Consultant* customized the Welcome Page in
ACT! by Sage 2010 or ACT! by Sage Premium 2010 for you, these customizations are lost as the
Welcome Page was redesigned in Sage ACT! 2011.

Database synchronization Accept Incoming Syncs ON setting. The ON setting for Accept
Incoming Syncs is disabled for customers upgrading from ACT! by Sage 2007 (9.x) and later versions.
You must turn database synchronization ON. The port number is retained.

ACT! Synchronization Services (Network and Internet Synchronization Services). You
must uninstall earlier versions of the Sync services, and then install versions that work with Sage ACT!
Premium 2012. To uninstall a Sync service, use Control Panel>Add/Remove Programs. To install the
new versions, see "Installing Other Applications" on page 9.

*Certified Consultants are third-party vendors. Sage and its affiliates are in no way liable or responsible for claims made
related to the services provided by third-party vendors.
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Installing Sage ACT! 2012

The following sections explain the required components, other considerations, and how to:
e Preparetoinstall.
e Install Sage ACT! 2012.
e Register and activate the software.
e Upgrade your previous version database to a Sage ACT! 2012 database.

Several final sections explain upgrade changes that may affect where your data appears and other
information you may need to know.

Required Components
To install and function correctly, Sage ACT! 2012 requires the following components:
e Windows® Installer 4.5
e .NET Framework 3.5 SP1
e Microsoft® SQL Server® 2008 R2 Express

If you do not have a required component, it is installed for you. To help you plan your installation, a
page appears listing the needed components for your operating system, approximate install time, and
if a restart (reboot) is required. You can select to continue the installation or cancel and install later.

NOTE: You can choose to skip installation of SQL Server Express if users will be connecting to a
shared Sage ACT! database with SQL Server. However, SQL Server Express must be installed on the
computer hosting the shared database. For Sage ACT! Premium (access via web) users, SQL Server
Express must be installed on the database server or web server, depending on your configuration.
See the Sage ACT! Premium 2012 Web Administrator's Guide.

Other Considerations

Other add-on products. Some applications added as plug-ins or add-on products in earlier ACT! or
ACT! by Sage versions may not upgrade to Sage ACT! 2012. These applications may require re-
installation after installing the software. Visit www.actsolutions.com or contact your add-on product
provider to determine compatibility.

Microsoft Outlook®, Word, and Excel® integration. Sage ACT! 2012 integrates with Microsoft
Outlook, Word, and Excel. (For compatible versions, see System Requirements at
www.act.com/2012systreq.) If you plan to use the integration features, ensure the Microsoft products
are installed before Sage ACT! 2012 and working correctly. You must set up an Outlook profile. To
configure and set up integration for Sage ACT! Pro or Sage ACT! Premium users after installation, see
Help. To configure and set up integration for Sage ACT! Premium (access via web) users, see the Sage
ACT! Premium 2012 Web Administrator's Guide.

Preparing to Install

Before installation, complete these steps in the order presented. Customers on ACT! Premium for Web
(all versions) or those planning to install Sage ACT! Premium 2012 (access via web), must also
complete the second set of preparation steps.

Prepare to install (all versions)

1. Ensure your computer (or all computers in a shared environment) meet the minimum
recommended system requirements for your purchased product and operating system. Also,
verify you meet the concurrent user limits and licenses. See system requirements at:
www.act.com/2012systreq.
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2. Ensure you are current with Microsoft critical and recommended updates.
3. Restart all computers to free available resources before you install.

4. Sign on to all computers as a Microsoft Windows Administrator. (If you do not, installation may
fail.)

5. Disable any software-based firewalls. You can enable these after installing Sage ACT! 2012.

6. Sage ACT! 2012 integrates with compatible versions of Microsoft Outlook, Word and Excel. For
compatible versions, see www.act.com/2012systreg. Ensure the Microsoft software is installed
and working correctly before installing Sage ACT! 2012. You must have an Outlook profile
configured for Outlook integration setup.

7. Customers on ACT! or ACT! Premium for Workgroups 2005 (7.x) through ACT! by
Sage or ACT! by Sage Premium 2009 (11.x) only: Synchronize remote databases to
one, main database. After you install and upgrade the database, you can create new remote
databases.

8. Customers on any Sage ACT! Premium or ACT! by Sage Premium version who are
planning to upgrade to Sage ACT! Pro, a non-premium version: You must downgrade
the premium database before installing Sage ACT! Pro. The premium database will not open in
the non-premium version. For steps to downgrade, see "Downgrading a Premium Database"
on page 11.

9. Open your current ACT! or Sage ACT! software and perform database maintenance. On the
Tools menu, click Database Maintenance.

Prepare to install Sage ACT! Premium (access via web) or upgrade to Sage or ACT!
Premium (access via web) from earlier versions of ACT! Premium for Web

1. Sage ACT! Premium requires that Microsoft Internet Information Services (IIS) and ASP.NET
run in 32-bit compatibility mode. If you use 64-bit versions of these applications and do not
want the installer to switch them to 32-bit mode, see the solution under "General Errors and
Issues" in the "Troubleshooting Sage ACT! Premium (access via web)" section of the Sage
ACT! Premium 2012 Web Administrator's Guide.

2. See Microsoft documentation to help you plan your installation and prepare your web server.
You need to understand your operating system, IIS, ASP.NET, and user permissions required
torun a web page.

3. Install, or enable, the correct version of IIS for your operating system. Verify it runs properly.
Some supported operating systems automatically install IIS, however, you may have to
enable it.

Install ASP.NET or verify that ASP.NET impersonation authentication is enabled.
5. Ifyou are using a firewall, enable an exception for World Wide Web services.

6. Give your web server a static IP address and make a note of it. You will need it later when you
configure access.

7. Gather the virtual directory or virtual server names of other web sites hosted on your web
server.

8. Ifyou use Windows XP, disable Simple File Sharing.

9. Ifyou use Windows Vista® as a web server to host Sage ACT! Premium (access via web),
change the "sleep mode" setting to Never.

2 Sage ACT! 2012
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10. Customers on earlier versions of ACT! Premium for Web or Sage ACT! Premium

(Web):
a. Have web userslog out of the ACT! Premium for Web or Sage ACT! Premium (Web)
database.

b. Open ACT! Premium for Web or Sage ACT! Premium (Web) and use the Web
Administration tool to remove the database from the web site. Once the database
upgrade is complete, you can add the database back to the web site and reset IIS.

Installing Sage ACT! 2012

IMPORTANT: If you are installing Sage ACT! Premium 2012 (access via web) in a multiple-server
configuration, install the application on the database server (even though you will be running it from
the web server). Installing on the database server creates the Microsoft SQL Server instance for Sage
ACT!. You connect to the database from the web server. Customers on earlier versions of ACT!
Premium for Web or Sage ACT! Premium (Web), install Sage ACT! Premium 2012 (access via web) on
the server with the earlier version.

Install Sage ACT! 2012 (all versions)

1.
2.

Close all open applications.

Do one of the following:

e Complete the download process from the Sage ACT! web site.

e Double-click the setup.exe file if you are installing Sage ACT! from a network location.

e Insert theinstallation DVD. The installation program should automatically start, but if it
does not, click Start, and select Run. Type <drive letter>:SETUP.

The installation panel appears with links to install Sage ACT!, install Synchronization Services
(Sage ACT! Premium only), and access product documentation and online resources.

NOTE: In the installation process, if a message appears about Microsoft .Net Framework 4
Client Profile, you can just click OK to continue. No action is necessary.

Click Install Sage ACT!.

On the Installation Requirements page, review the information. To continue with
installation, click Next. (To cancel and install later, click Cancel.)

If prompted, agree to install the required components. A restart may be necessary after
installation. NOTE: If installation does not automatically start after a required restart, click
Setup.exe to continue.

On the Regional Version page, select the version to install. Click Next.
At the "...Earlier version detected and needs to be uninstalled" message, click Yes to continue.

On the License Agreement page, read the agreement, and then click Accept. (If you
Decline, installation is cancelled.)

On the Type of Install page, Typical installation is selected by default. To change the default
install settings, select Custom. Click Next.

NOTE: With a Custom installation, you can select to install Sage ACT! 2012 without SQL
Server Express 2008 R2. To do this, clear the Install SQL Server Express check box on the
next page. IMPORTANT: If you do not install SQL Server Express, you cannot create or
restore a database. However, you can connect to a shared database. For more information,
see the Knowledgebase and system requirements. Other custom options let you choose
where to install Sage ACT! and SQL Server Express, select who can use Sage ACT!, specify
icons for Quick Launch, and where to place Sage ACT! in the Start Menu.

Upgrading to Sage ACT! 2012
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10. When the Install Complete page appears, click Finish.

11. (Optional) To close the installation panel, click Exit. You can use this panel again to access and
print product documentation or to install Sage ACT! Premium Synchronization Services.

To open Sage ACT!: Double-click the Sage ACT! icon on the desktop. Or, on the Start menu, under
Programs, point to the Sage ACT! program folder, and then click Sage ACT!. When the software
opens, you are prompted to register and activate it. You can choose to register now or use the

software for a trial period of 30 days. For more information about the trial period, see Sage ACT!
Help.

Registering and Activating Sage ACT!

You must register and activate Sage ACT! within 30 days of first use on each computer where it is
installed. Registration and activation provides you with program updates and customer support
options. A serial number is required to register. The serial number is printed on the DVD sleeve or is
emailed to you upon purchase. You can copy the serial number from the product activation email and
paste it into the registration page.

Windows Vista and Windows 7: You must run the software as an Administrator to register it.

Close Sage ACT!. Right-click the Sage ACT! icon on the desktop or in the Program Files list. Click Run
as administrator.

Register and activate the software
1. Onthe Help menu, click Register Sage ACT!.
2. Select a registration option. Click Next.
3. Follow the on-screen instructions. Click Next to advance.
4. When finished, click Activate. If error messages appear, follow the instructions.

Upgrading a Database

The following explains how to upgrade an earlier version (ACT! 2005 - 2011) database to a Sage
ACT! 2012 database.
Upgrade a database to Sage ACT! 2012
1. Open Sage ACT! 2012.
or

If Sage ACT! 2012 is already open, when the logon screen appears, enter the user name and
password for the database you want to upgrade. Go to step 4.

2. Onthe Welcome screen, ensure Open an existing Sage ACT! database is selected, and
then click OK.

3. Inthe Open/Share Database dialog box, select the database. Click Open Database.
o This Open/Share Database dialog box was an improved feature added to Sage ACT! 2012. You

can easily locate, open, and share a database using the Open/Share Database command on the
File menu or the Welcome screen.

4. When prompted to back up the database before upgrading, click Yes.
We recommend that you back up the database so that if you want to reinstall the earlier version
L]

1 -, of the software, the database backup copy can be restored in that version. The upgrade
process overwrites your earlier version database, but does not affect the backup copy.
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5. Follow the directions on any update and verification prompts that appear.
6. When the update process is complete, click OK.

7. (Optional) If the database was shared with others, click File, then Open/Share Database to
ensure it remained shared. If it did not remain shared, click Share. To open the database, click
Open Database.

Upgrade Changes That May Affect Where Your Data Appears

If you are upgrading from a version prior to ACT! by Sage 2010, the following sections provide an
overview of some of the significant changes to the interface for the Sage ACT! 2012, Sage ACT! 2011,
and ACT! by Sage 2010 releases. For more information about new and improved features for each
previous release, see the Knowledgebase.

Sage ACT! 2012 Changes
The following items are some of the new features and improvements.

New Search. A universal Search feature was added. To access the new Search, a search text box was
added to the right of the global toolbar and a Search button was added to the navigation bar. The
Lookup Search button was removed from the global toolbar.

New Sage Connected Services view. A new Connections view was added to the navigation bar.
You use the Connections view to sign up for, use, manage, and learn more about services and features
integrated with Sage ACT!.

New Sage ACT! Scratchpad. A new feature called Sage ACT! Scratchpad was added to the Tools
menu.

New Google® integration. New commands were added to the Contacts, Schedule, and Tools
menus to enable integration with your Google contacts and calendar and Gmail® record history to
Sage ACT!.

ACT! sync service for Outlook sync was renamed to Sage ACT! Integration service. The
ACT! sync service for Outlook sync was renamed to Sage ACT! Integration service because it also
enables Google integration. You can select to integrate your contacts and calendar with Google or
Outlook.

Sage ACT! 2011 Changes

Data security, Outlook Contact and Calendar synchronization, and other improvements required
changes to the interface.

New Admin tab added to Preferences. This new Admin* tab was created to combine existing
Administrator-level (and some Manager-level) preferences from other tabs and to display new
preferences. If you cannot see the Admin tab, use the arrow buttons to scroll through the tabs.

Notes and History preferences moved from General tab to Admin tab. The check boxes for
the “Allow history editing” and the “Allow notes editing” options were moved from the General Tab
(under General Preferences) to the new Admin tab. Your current settings are retained.*

Names Preferences moved from General tab to Admin tab. On the General Tab, replaced the
“Names” group with a “Salutation” group and moved access to the “Name Preferences” option to the
new Admin tab. Your current settings are retained.*

Companies Preferences moved from Startup tab to Admin tab. Moved access to the
“Company Preferences” options from the Startup tab to the new Admin tab. Your current settings are
retained.*

Duplicate Checking Preferences moved from General tab to Admin tab. Moved the “"Disable
or enable duplicate checking” option from the General tab to the new Admin tab. Your current settings
are retained.*

Upgrading to Sage ACT! 2012 5



Outlook Copy Calendar preferences converted to Outlook Synchronization preferences.
Copy Calendar is now full calendar synchronization. The Copy Calendar setup was moved from the
Calendar & Scheduling tab to the renamed E-mail and Outlook Sync tab under Preferences. Your copy
calendar preferences are retained as calendar synchronization preferences.

Renamed E-mail tab to E-mail and Outlook Sync tab. This tab was renamed to include Outlook
synchronization options and to better display e-mail setup options.

New Web Info tab links category. New integration with Sage Business Info Services for ACT!
required changes to the Contact and Company Web Info tab. Your existing links are upgraded and now
are labeled User Links and appear on the left.

Welcome Page redesign. The Welcome Page introduced in ACT! by Sage 2010 was redesigned to
provide better usability.*

Change to Sage ACT! Scheduler for Manager users regarding attachments to backups.
Data security changes for attachments in Sage ACT! 2011 included a new security setting that allows
only Administrator users to back up attachments with the database. If you have a Manager user with
scheduled database backup tasks in the Sage ACT! Scheduler, those backup tasks will upgrade;
however, no attachments will be backed up. You must delete any database backup tasks with
attachments scheduled for a Manager and set them up again for an Administrator.

New categories to filter by history types on the History tab. New categories of histories by
type (such as e-mails and correspondence, completed activities, system changes, or attached files),
were added to the History tab. These new categories let you drill down to see the histories.

*These changes apply to the desktop applications only; not to the web client application.

ACT! by Sage 2010 Changes

Opportunities were redesigned to work in the same way as Contacts, Groups, and Companies. Other
new features may affect where and how you access your existing data.

New Opportunity Detail view. A new Opportunity Detail view layout was added. The layout has the
same default tabs as the contact, group, and company layouts. After upgrading your database, some
of the changes include:

e Groups and Companies associated with an opportunity appear on the Groups/Companies tab.
o Details for an opportunity become notes and appear on the Notes tab.

e Follow-up activities scheduled for an opportunity appear on the Activities tab.

e History information, such as the date the opportunity was opened, appears on the History tab.
e Opportunity record access, such as public or private, appears on the Opportunity Access tab.

New Welcome Page. A new Welcome Page is the default Sage ACT! view that opens when you open
a database. This page has links to Help topics, feature tours, and more. You change the default view to
open in Preferences.

New Navbar, global toolbar, and view toolbars. The navigation bar was redesigned to include
more views, such as Reports and Opportunities. A Related Tasks area was included in the Navbar for
easy access to tasks. A global toolbar with large buttons makes it quicker for you to get to the tools you
need. Each view has its own view toolbar.

New Web Info tab for Contacts and Companies. The Web Info tab is an internal browser that
lets you display web pages specific to a contact or company.

Internet Services and Favorite links moved. Internet Services links appear on the new Web Info
tab for Contacts and Companies. Favorite links are accessed from the View menu.

6
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Sage Connected Services for ACT!

Sage ACT! 2012 offers subscription-based services, most with trial periods or free levels, and links to
integrated applications. To see all services and integrated apps, on the left navigation bar in Sage ACT!,
click Connections.

Sage E-marketing for ACT! (powered by Swiftpage™, a third-party company). A subscription-based
email marketing service that executes marketing campaigns using techniques proven to build your
business.

Sage Business Info Services for ACT! (provided by Hoover's™, a third-party company). A
subscription-based service that provides targeted prospect lists and business information from
Hoover’s and lets you access the information from Sage ACT!.

Sage ACT! Connect*. A subscription-based cloud service that delivers Sage ACT! contacts and
calendar through a supported web browser.

Google® and Gmail® Integration. You can integrate Sage ACT! with your Google contacts and
calendar and record histories of emails sent or received from your Gmail account.

*Review Sage ACT! Connect system requirements at www.act.com/connectsystreq to confirm supported web
browsers, tablets, and mobile phones.

Next Step(s)
Single Users:

e Readthe Quick Start for New Users guide or watch Featured Videos accessed from the Welcome
Page.

Sage ACT! Premium (access via web) Users:
1. Assign the upgraded database to the web site and reset IIS.

2. Verify access for your web users and complete other configuration tasks. See the Sage ACT!
Premium 2012 Web Administrator's Guide.

Workgroup Users:
1. Readthe Quick Start for New Users guide or watch Featured Videos accessed from the Welcome
Page.

2. Ifyou use a shared database, ensure all users install the same Sage ACT! 2012 version. Then,
you can distribute a shortcut to the .PAD file for the database. (The .PAD file is pointer to the
database. Users open a database from the .PAD file.)

3. Create new remote databases for database synchronization (not required for previous ACT! by
Sage 2010 or Sage ACT! 2011 users). For more information, see "About Database
Synchronization" in Help.
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Installing Other Applications

The section explains how to install:
e Adobe Reader
e Sage ACT! Synchronization Services (available for Sage ACT! Premium only)

Adobe Reader

You must have Adobe Reader installed to view product documentation. You can install a free copy from
the Adobe web site.

Install Adobe Reader
1. Ontheinstallation panel, click Product Documentation.
2. Click thelink to go to the Adobe web site to download and install Adobe Reader.

Sage ACT! Synchronization Services

Sage ACT! Premium offers two data synchronization services. These services let remote workgroup
users, with their own Sage ACT! Premium database, synchronize their data to the main workgroup
database without Sage ACT! Premium being opened and active. You can install one or both services
depending on your needs. For more information about database synchronization, see Help.

Sage ACT! Network Synchronization Service. Lets you synchronize Sage ACT! Premium
databases over a network. This service can be used by remote users connected to the main database
via a Local Area Network (LAN), Wide Area Network (WAN), or a Virtual Private Network (VPN). You
can install the service on the same computer as Sage ACT! Premium or on another computer.

Sage ACT! Internet Synchronization Service. Lets you synchronize Sage ACT! Premium
databases over the Internet. This service requires a computer (located outside the firewall) with
ASP.NET and Microsoft Internet Information Services (IIS) installed (compatible with your operating
system). See system requirements at: www.act.com/2012systreq.

NOTE: Sage ACT! Pro users can synchronize data between a main and remote database, but do not
use the synchronization services. For Sage ACT! Pro database synchronization, the Sage ACT!
application must be open on the computer hosting it. For more information, see Help.

Installing Sage ACT! Sync Services

The following explains how to install a Sage ACT! Sync service. You install one service at a time. After
installation, you must set it up (configure it).

IMPORTANT: If you install the Sage ACT! Internet Sync Service on a computer that does not have
Sage ACT! Premium installed, ensure the <computer name>\ASPNET account has read/write
permissions on the Internet Sync install folder. For more information, see Help.
Install a Sync Service
1. Open theinstallation panel, double-click the setup.exe file, or insert the installation DVD.
2. On theinstallation panel, click Install Sage ACT! Synchronization Services.
3. Click thelink to install a sync service.
4. Follow the on-screen instructions. Click Next to advance. Click Finish.

Next Step(s)

1. Setupthe Sync Services. See Help.
2. Get started using Sage ACT! Premium.
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Downgrading a Premium Database

Downgrading a premium database removes several premium features and allows the database to be
used with a non-premium version of the software. After downgrading the database, do not reopen the
database until you have installed the non-premium product. Be aware of the following considerations
if you are planning to downgrade a premium database.

Who can downgrade a database? Only ACT! Administrator or Manager users can downgrade a
premium database.

When should you downgrade a database? You must downgrade the database before you
uninstall the premium application.

What happens to database fields with access level of No Access? Fields with an access level
of No Access convert to Read Only access. No Access field-level security is not available in a non-
premium database.

What happens to database synchronization when I downgrade my premium database?
The database synchronization relationship between main (Publisher) and remote (Subscriber)
databases is lost. Therefore, you should synchronize all remote databases to the main database before
uninstalling the premium version. You then downgrade the premium, main database. Once you open
the main database in Sage ACT! Pro (non-premium version), you can create up to 50 new remote
databases.

Downgrade a premium database to a non-premium database

1. (Optional) Synchronize all remote databases with the main premium database.

2. Inthe premium application, on the File menu, click Save Copy As.

3. Inthe Database Name field, type the name of the new database.

4. Inthe Database Location field, type the location for the database, or click Browse to locate
a folder to save the new database to.

5. ACT! by Sage 2010 or Sage ACT! 2011 users only: Select a currency for the database.

6. Toshare the database with other users, select the Share this database with other users
check box.
7. IMPORTANT: In the Database Version list, select ACT! (Year), orif you are using Sage

ACT! Premium, select Sage ACT! Pro. Be sure to select the item that does not have Premium
in the title. You need the database to be a non-premium version.

8. Click OK.
9. A prompt appears about default permissions of fields changing from No Access to Read Only.
Click OK.

10. The saving status message appears until the process is complete. Click OK.

Next Step(s)
1. Install Sage ACT! Pro 2012 and open the database.
2. Create new remote databases for database synchronization. See Help.
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Addendum A: Upgrading from ACT! by Sage for Financial
Professionals (All Versions)

This addendum explains how to upgrade to Sage ACT! Pro or Sage ACT! Premium 2012 from:

e ACT! by Sage for Financial Professionals or ACT! by Sage Premium for Financial Professionals 2007
(9.x)

e ACT! by Sage for Financial Professionals or ACT! by Sage Premium for Financial Professionals 2008
(10.x)

e ACT! by Sage for Financial Professionals or ACT! by Sage Premium for Financial Professionals 2009
(11.x)

e ACT! by Sage for Financial Professionals or ACT! by Sage Premium for Financial Professionals v12

Note: Sage is not developing additional versions of ACT! by Sage for Financial Professionals or ACT! by
Sage Premium for Financial Professionals beyond version 12.

Features exclusive to Sage ACT! Premium or ACT! by Sage Premium for Financial Professionals are noted
in this addendum. In most cases, we refer to both versions as Sage ACT! 2012 or ACT! for Financial
Professionals, respectively.

Important: We recommend you read this addendum as well as the other sections of this guide before
installing Sage ACT! 2012. You will need to follow several sections of the guide to install, register and
activate, and upgrade your database. Sage ACT! Premium includes access via Windows (desktop) and
web. If you are installing access for users via the web, then you will need this guide and the Sage ACT!
Premium 2012 Web Administrator's Guide to complete installation and configuration. The Web
Administrator's Guide is available on the web product's installation panel under Product Documentation.
You can browse the installation files directory for the guide as well. It is recommended that you read the
Web Administrator's Guide before installing the web version.

Sections in this addendum explain:
e What you should know before upgrading to Sage ACT! 2012.
e ACT! for Financial Professionals features that upgrade and do not upgrade.
e How to upgrade to Sage ACT! 2012.

What You Should Know Before Upgrading to Sage ACT! 2012

This section contains information you should know before upgrading to Sage ACT! 2012. In addition to
the items listed in this addendum, see "What You Should Know Before Upgrading" on page ii.

For ACT! by Sage for Financial Professionals Customers Upgrading to Sage ACT! 2012.
When you upgrade to Sage ACT! 2012, certain vertical-specific features will not upgrade. For a complete
listing of those features, see "Features That Do Not Upgrade" on next page. Some features that do not
upgrade may require you to make changes in ACT! for Financial Professionals before upgrading to Sage
ACT! 2012.

ACT! Premium for Financial Professionals customers planning to install Sage ACT! Pro
2012. You must downgrade the premium database before installing Sage ACT! Pro. The premium
database will not open in the non-premium version. For steps to downgrade, see "Downgrading a
Premium Database" on page 11.

The database upgrade process overwrites the earlier version database. It isimportant to have
a backup copy of the database in case you want to re-install the earlier version of the software. Back up
the database before starting the upgrade process.

Who can upgrade a database? An ACT! Administrator or Manager user can upgrade a local database.
On a remote database, an Administrator, Manager, or Standard user (with permission) can upgrade the
database they belong to.
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Database synchronization recommendations. The following recommendations are for customers
using database synchronization.

e Customers upgrading from versions other than v12. The database synchronization
relationship is retained. However, because of opportunity data changes made in ACT! by Sage
2010, you can synchronize remote (Subscriber) databases to one, main (Publisher) database
before upgrading. Then, upgrade the main database and create new remote databases. The new
opportunity data changes will synchronize. If you use the ACT! Sync services with Premium
versions, you must uninstall the Sync Services and install the versions that are compatible with
Sage ACT! Premium 2012. Sage ACT! 2012 allows you to create up to 50 remote databases at one
time.

e Customers upgrading from v12. You do not need to recreate remote databases. You can
upgrade a remote database after you install Sage ACT! 2012. If you use the ACT! Sync services
with ACT! Premium for Financial Professionals, you must uninstall the Sync services and install the
versions that are compatible with Sage ACT! Premium 2012.

Features That Upgrade

Depending on the ACT! for Financial Professionals version you are upgrading your database from, the
following ACT! for Financial Professionals default features upgrade for use in Sage ACT! 2012.

Layouts, fields, and tabs. After upgrading, you may have to select the Financial Professionals layout
from the layout selector list located in the view toolbar. ACT! for Financial Professionals layouts include
"FP" in the layout name. The Financial Professionals tabs on the Contact Detail view, including all fields,
upgrade. However, on the Address tab and Personal Info tab, several items do not upgrade. See the next
section "Features That Do Not Upgrade" for more information. For a complete list of the ACT! for
Financial Professionals fields and tabs, see the Knowledgebase article.

Activity series. After upgrading, the default Activity series are available from the Schedule menu.

Features That Do Not Upgrade

In addition to the "Items That Do Not Upgrade" listed in "What You Should Know Before Upgrading" on
page ii, the following ACT! for Financial Professionals features do not upgrade for use in Sage ACT! 2012.
This list includes recommendations for what you can do in lieu of the feature that does not upgrade.

Backup Preferences. The Backup Preferences feature is removed from the Tools menu. You can use
the Sage ACT! Scheduler to schedule database backups.

Contact Recorder and Remember Contact. The Contact Recorder and Remember Contact features
are removed from the Tools menu. You can use the Sage ACT! Scratchpad to help you remember
contacts you were working with.

Missing Info. The Missing Info feature is removed from the Tools menu. You can check for missing
contact information in ACT! for Financial Professionals before upgrading to Sage ACT! 2012. After
upgrading, you can run reports or lookups to help you find records with missing information.

Address tab Primary button. The Primary button used to change a contact's primary address in the
upper portion of the contact layout does not upgrade. You can update the primary address in ACT! for
Financial Professionals before upgrading to Sage ACT! 2012. If you do not, you will have to manually
change the primary address for a contact.

Personal Info tab Age field. The Age field does not upgrade since it is a calculated field. You can
remove the age field from the contact layout in ACT! for Financial Professionals before upgrading to Sage
ACT! 2012.

Dynamic field labels. The function of dynamic field labels on the Address tab and the Contact Detail
view layout does not upgrade. The field labels and data are visible after upgrading; however, the function
to designate an address as primary does not work.
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How to Upgrade to Sage ACT! 2012

Upgrading from ACT! for Financial Professionals to Sage ACT! 2012 can be easily done if you follow these
recommended steps.

Upgrade to Sage ACT! 2012
1. Follow the preparation steps. See "Preparing to Install ACT!" on page 1.
2. In ACT! for Financial Professionals, do the following:
e Check for missing contact information.
e Remove the Age field from the contact layout.
e Ensure the primary address for each contact is updated.

o If applicable, synchronize all remote (Subscriber) databases to one, main (Publisher)
database.

3. If applicable, downgrade the Premium database to a non-premium tier. See "Downgrading a
Premium Database" on page 11.

4. Open Add/Remove Programs, and do the following:
e Uninstall ACT! for Financial Professionals.
e If applicable, uninstall ACT! Sync services.

5. Install, register and activate Sage ACT! 2012. See "Installing and Registering and Activating
Sage ACT!" on page 3.

6. Open Sage ACT! 2012 and upgrade the database. See "Upgrading Databases" on page 4.

7. If applicable, install Sync services. See "Installing Other Applications" on page 9.

Tip: To help you understand some of the interface changes since ACT! by Sage 2010, see "Upgrade
Changes That May Affect Where Your Data Appears" on page 5.
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Addendum B: Upgrading from ACT! by Sage for Real Estate (All
Versions)

This addendum explains how to upgrade to Sage ACT! Pro or Sage ACT! Premium 2012 from:
e ACT! by Sage Premium for Real Estate 2006 (8.x)
e ACT! by Sage for Real Estate or ACT! by Sage Premium for Real Estate 2008 (10.x)
e ACT! by Sage for Real Estate or ACT! by Sage Premium for Real Estate 2009 (11.x)
e ACT! by Sage for Real Estate or ACT! by Sage Premium for Real Estate v12

Note: Sage is not developing additional versions of ACT! by Sage for Real Estate or ACT! by Sage
Premium for Real Estate beyond version 12.

Features exclusive to Sage ACT! Premium or ACT! by Sage Premium for Real Estate are noted in this
addendum. In most cases, we refer to both versions as Sage ACT! 2012 or ACT! for Real Estate,
respectively.

Important: We recommend you read this addendum as well as the other sections of this guide before
installing Sage ACT! 2012. You will need to follow several sections of the guide to install, register and
activate, and upgrade your database. Sage ACT! Premium includes access via Windows (desktop) and
web. If you are installing access for users via the web, then you will need this guide and the Sage ACT!
Premium 2012 Web Administrator's Guide to complete installation and configuration. The Web
Administrator's Guide is available on the web product's installation panel under Product Documentation.
You can browse the installation files directory for the guide as well. It is recommended that you read the
Web Administrator's Guide before installing the web version.

Sections in this addendum explain:
e What you should know before upgrading to Sage ACT! 2012.
e ACT! for Real Estate features that upgrade and do not upgrade.
e How to upgrade to Sage ACT! 2012.

What You Should Know Before Upgrading to Sage ACT! 2012

This section contains information you should know before upgrading to Sage ACT! 2012. In addition to
the items listed in this addendum, see "What You Should Know Before Upgrading" on page ii.

For ACT! by Sage for Real Estate Customers Upgrading to Sage ACT! 2012. When you upgrade
to Sage ACT! 2012, certain vertical-specific features will not upgrade. For a complete listing of those
features, see "Features That Do Not Upgrade" on next page.

ACT! Premium for Real Estate customers planning to install Sage ACT! Pro 2012. You must
downgrade the premium database before installing Sage ACT! Pro. The premium database will not open
in the non-premium version. For steps to downgrade, see "Downgrading a Premium Database" on page
11.

The database upgrade process overwrites the earlier version database. It is important to have
a backup copy of the database in case you want to re-install the earlier version of the software. Back up
the database before starting the upgrade process.

Who can upgrade a database? An ACT! Administrator or Manager user can upgrade a local database.
On a remote database, an Administrator, Manager, or Standard user (with permission) can upgrade the
database they belong to.
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Database synchronization recommendations. The following recommendations are for customers
using database synchronization.

e Customers upgrading from version 2006 (8.x). The database synchronization relationship
is lost. You can synchronize remote (Subscriber) databases to one, main (Publisher) database
before upgrading to Sage ACT! 2012. Then, upgrade the main database and create new remote
databases. Sage ACT! 2012 allows you to create up to 50 remote databases at one time.

e Customers upgrading from versions 2008 (10.x) or 2009 (11.x). The database
synchronization relationship is retained. However, because of opportunity data changes made in
ACT! by Sage 2010, you can synchronize remote (Subscriber) databases to one, main (Publisher)
database before upgrading. Then, upgrade the main database and create new remote databases.
The new opportunity data changes will synchronize. Sage ACT! 2012 allows you to create up to 50
remote databases at one time. If you use the ACT! Sync services with your Premium version, you
must uninstall the Sync Services and install the versions that are compatible with Sage ACT!
Premium 2012.

e Customers upgrading from v12. You do not need to recreate remote databases. You can
upgrade a remote database after you install Sage ACT! 2012. If you use the ACT! Sync services
with ACT! Premium for Real Estate, you must uninstall the Sync services and install the versions
that are compatible with Sage ACT! Premium 2012.

Features That Upgrade

Depending on the ACT! for Real Estate version you are upgrading your database from, the following ACT!
for Real Estate features upgrade for use in Sage ACT! 2012.

Layouts. After upgrading, you may have to select the Real Estate layout from the layout selector list
located in the view toolbar. ACT! for Real Estate layouts include "RE" in the layout name.

Activity types. After upgrading, to manage the real estate activity types, on the Schedule menu, point
to Manage, and then click Activity Types. To schedule a real estate activity, on the Schedule menu, point
to Other, and then select a real estate activity.

Activity series. After upgrading, to manage the real estate activity series templates, on the Schedule
menu, point to Manage, and then click Activity Series. To schedule a real estate activity series, on the
Schedule menu, click Activity series. Select a real estate template from the list.

Opportunity processes and stages. After upgrading, to manage the real estate opportunity
processes and stages, on the Navbar, click Opportunities. On the Opportunities menu, click Manage
Process List.

Reports. After upgrading, the Real Estate submenu is removed from the Reports menu. To run a real
estate report, on the Navbar, click Reports and select a real estate report from the list.

Mail merge templates. After upgrading, the Real Estate submenu is removed from the Write menu.
To use a real estate template, on the Write menu, click Other Document (from template).

Activities and Opportunities Dashboards. After upgrading, to select a Real Estate Dashboard, on
the Navbar, click Dashboards. From the Dashboard list, select Real Estate Activities or Real Estate
Opportunities.

Features That Do Not Upgrade

In addition to the "Items That Do Not Upgrade" listed in "What You Should Know Before Upgrading" on
page ii, the following ACT! for Real Estate features do not upgrade for use in Sage ACT! 2012. This list
includes recommendations for what you can do in lieu of the feature that does not upgrade.

MLS Access and MLS Access Setup. After upgrading, the MLS Access and MLS Access Setup features
are removed from the View menu. To set up a link to the MLS Site, you can use the Manage Links
feature accessed from the ACT! Links submenu of the View menu.
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How to Upgrade to Sage ACT! 2012

Upgrading from ACT! for Real Estate to Sage ACT! 2012 can be easily done if you follow these
recommended steps.

Upgrade to Sage ACT! 2012

1.
2.
3.

6.
7.

Follow the preparation steps. See "Preparing to Install ACT!" on page 1.

If applicable, synchronize all remote (Subscriber) databases to one, main (Publisher) database.

If applicable, downgrade your Premium database to a non-premium tier. See "Downgrading a
Premium Database" on page 11.

Open Add/Remove Programs, and do the following:

e Uninstall ACT! for Real Estate.

e If applicable, uninstall ACT! Sync services.

Install, register and activate Sage ACT! 2012. See "Installing and Registering and Activating
Sage ACT!" on page 3.

Open Sage ACT! 2012 and upgrade the database. See "Upgrading Databases" on page 4.

If applicable, install Sync services. See "Installing Other Applications" on page 9.

Tip: To help you understand some of the interface changes since ACT! by Sage 2010, see "Upgrade
Changes That May Affect Where Your Data Appears" on page 5.
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